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Disclaimer / Notes

“Preliminary” product information describes a product which is not in full production so
that full information about the product is not available yet. Therefore, acam-messelectronic
gmbh (“acam”) reserves the right to modify this product without notice. The information
provided by this data sheet is believed to be accurate and reliable. However, no
responsibility is assumed by acam for its use, nor for any infringements of patents or
other rights of third parties that may result from its use. The information is subject to
change without notice and is provided “as is” without warranty of any kind (expressed or
implied). PICOCAP® is a registered trademark of acam. All other brand and product names
in this document are trademarks or service marks of their respective owners.

Support / Contact
For a complete listing of Direct Sales, Distributor and Sales Representative contacts, visit
the acam web site at:

http: //www.acam.de/sales/distributors/

For technical support you can contact the acam support team in the headquarters in
Germany or the Distributor in your country. The contact details of acam in Germany are:

support@acam.de or by phone +49-7244-74190
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1 Introduction

1.1 General

The PCap@1-EVA-KIT evaluation system provides a complete system for generally
evaluating the PCap@1 chip. It comprises of a main board, a plug-in module, a Windows
based evaluation software, assembler software and the PICOPROG programming device.
The PCap@d1 evaluation board is connected to the PC's USB interface through the
PICOPROG V2.0 programming device.

The evaluation kit offers user friendly configurations for evaluating the PCapd1 single-chip
solution for capacitance measurement. This kit can be used to evaluate the capacitance
measurement, temperature measurement and the pulse generation capabilities of the
PCapd1 chip.

For a proper use of the evaluation system it is strongly recommended to refer to the
current PCapd1A datasheets (DB_PCap01-0301, DB_PCap0O1_DSP etc.]). You can

download these datasheets from www.acam.de/download-center/picocap .

1.2 Component List

= PCapgd1-MB Motherboard

= PCO1-AD Plug-in module Based on PCapd1-AD in QFN32 package

= PICOPROG V2.0 Programmer

» High density DSUB15 cable Connecting the Evaluation board to the
programmer

= USB cable Connects PICOPROG V2.0 to the PC

»  \Wall power supply unit gV

= (CD-ROM Includes software and data sheets

1-2 acam messelectronic gmbh - Friedrich-List-Str.4 - 76297 Stutensee - Germany - www.acam.de
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Figure 1-1: Components of the evaluation kit
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2 Connecting Capacitors and Resistors

This evaluation kit can be used for evaluating capacitance measurement by connecting capacitive
sensors. Further, it can be used for evaluating temperature measurement by connecting external
temperature sensitive resistors or for generating quasi analog voltage (pulse width/density

modulated) that is dependent on the sensor connected to the system.

Depending on the purpose of evaluation, a modification has to be made to the same plug-in

module. Following is a picture of the Mother board with the plug-in module.

Figure 2-1: The evaluation kit's motherboard and plug-in module

The following sections describe the modifications for each application in detail.

2.1 Capacitance Measurement

For the purpose of evaluating the capacitance measurement using PCapd1, the plug-in module is
pre-assembled with ceramic capacitors to emulate capacitive
sensors. These capacitors, each 47pF in value, are connected
to the 8 ports PCO to PC7. They are connected as single
sensors in floating mode, i.e. each capacitor is connected
between 2 ports, and hence there are 4 x 47pF on-board
capacitors. Please refer to Section 3.4 of the PCapd1 Data

Sheet for more information on how to connect capacitors to the

chip. The capacitor connected between ports PCO and PC1 is et aiice
) capacitor Ceramic capacitors 47 pF each
taken as the reference capacitor. 47 pF

Figure 2-2: Details of the plug-in module

2-4 acam messelectronic gmbh - Friedrich-List-Str.4 - 76297 Stutensee - Germany - www.acam.de
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In the process of evaluation, when you are comfortable with interpreting the measurement results
from the chip, these fixed capacitors can be replaced with the actual capacitive sensors of your

application.

If you want to connect your capacitive sensors in grounded mode, then GND points are provided

at the two ends of the module, where the sensor ground connections ought to be soldered.

The typical value of the capacitive sensors that can be connected to the evaluation kit lies in the
range of 30pF to 3.5nF. The reference capacitor should be in the same order of magnitude as
the sensor. Depending on the value of the sensor, the value of the internal resistor for performing
the measurement has to be selected. For the pre-assembled 47pF capacitors, an internal
discharge resistor of 180k0Ohm works well. See section 3.5 of the PCapd1 data sheet on how to

select the value of the internal discharge resistor.

2.2 Temperature Measurement

Temperature measurement or other resistive tasks may also be of interest for the user of this kit.
The evaluation kit offers this possibility through the RDC (resistive-to-digital converter) ports. An
on-chip thermistor coupled with an on-chip temperature-stable reference resistor made of

palysilicon is sufficient for observing the temperature measurement capability of the PCapd1 chip.

Port PT1 for 2nd external
temperature sensor

(not supported by the
standard firmware)

Port PTO for external
temperature sensor

Port PT2 for external
reference resistor

sselectronic GmbH
PGOT AD VLI
€

(23
N
(2}
(7]
me.

— 33 nF COG

SATYN

CTTTTILY!

EILTTTTNY
e
PC4 @

PC2
PC3 >
'PC5

 PCS
PC7

33
3,
3
¢

Figure 2-3: Temperature sensor connection pads

However, there is a possibility to connect the reference resistor and the thermistor externally to
the chip, too. In case of external resistors, the temperature-stable reference resistor ought to be
connected at port PT2REF on the plug-in module. The module allows you to connect the external
thermistor, e.g. a PT1000 sensor at port PTO (or PT1, not supported yet by the standard

firmware).
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In any case, for the temperature measurement, an external capacitor 33 nF COG has to be

connected to the chip; it is already pre-assembled on board.

2.3 Pulse Code Generation

Any of the capacitance or temperature measurement results from the PCapd1 chip can be given
out as a pulse width modulated or pulse density modulated signal. This output can be filtered to

generate an analog output signal that can be used for further controlling.

These pulse width or pulse density codes can be generated at Ports PGO, PG1, PG2 or PG3.
Since ports PGO and PG1 are used for the SPI Interface in the module, the hardware allows to get
a valid pulse width/density modulated signal on PG2 or PG3. However, when 12C communication

mode is used the pulsed signals can be optionally obtained on the ports PGO and PG1.

PG2

Figure 2-4: General purpose interface ports PGO to PG3

2.4 Motherboard

The motherboard connects to the PICOPROG programmer. It serves the various power options. It
can be powered via wall plug supply, the voltage being set from 1.8V to 4.5V by jumpers. Further,

it supports a battery power option. Power present is indicated by a green LED.

There is a jumper ‘Current’ on the mother board. The current consumption of the PCapd1 chip

during operation can be directly measured from these jumper terminals.

All interface signals and general purpose |/0 signals can be monitored by means of a separate

jumper.
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3 Evaluation Software

3.1 Installing the Software

The PCap@d1 -EVA software runs under the following operating systems

= Windows 2000
= Windows XP
» Windows Vista (please use the software/drivers for Windows 7]

=  Windows 7
Please follow the described procedure to install the software and driver:

NOTE: Ensure that the Picoprog V2.0 programmer is disconnected before starting the

procedure.
The steps are slightly different for Windows XP and Windows 7. Please note as follows.
Installation on Windows 7 systems:

» Install the PCapd1 Evaluation software from Software\ PCapO1-Evaluation-Software\
setup.exe from the CD. This .exe file installs the evaluation software and the
respective drivers for the Picoprog programmer too.

» At the end of step 1, a batch file comes up in a separate window. Eventually, it will
ask you to unplug the Picoprog V2.0 programmer. Please follow further the
instructions on the window.

» The driver will be installed; a windows message may pop up asking you to install the
driver though it is not signed. Please install it anyway.

» The batch file asks you to plug in the programmer and it is now enumerated.

* You will be asked to restart the system at this point, please do so. After restart
connect the evaluation board to the Picoprog programmer.

= On restart, launch the application from the start menu, if possible as administrator.
The software opens and a pop up window asks to select between a ‘Standard’ mode
and ‘Humidity’. Please select ‘Standard’.

» The LED on the Picoprog programmer will turn green. The software will initialize.

» Perform Verify Interface from the Eval.Software main window. If every is correctly
installed, the verify interface must result in an ‘Interface OK' message. Also, under
Help 2 Programmer 2 hdIUSB 2 USBO::0Ox1894E::Ox100B::NI-VISA ought to be

seen.
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= If you want to change from the default SPI to I2C interface, please select under
Tools =2 Interface 2 I2C interface. The LED on the Picoprog programmer should

now turn red.

Installation on Windows XP systems:

» Install the PCapd1 Evaluation software from Software\ PCap@d1-Evaluation-Software\
setup.exe from the CD. This .exe file installs the evaluation software and the
respective drivers for the Picoprog programmer too.

» At the end of step 1, a batch file comes up in a separate window. It will ask you to
reconnect the Picoprog V2.0 programmer.

*  You will then be asked to restart the system at this point, please do so.

* On restart, Found New Hardware wizard comes up. Please select ‘No, not this time’
and continue further with ‘automatic installation’.

= The driver will be installed; a windows message may pop up asking you to install the
driver though it is not signed. Please install it anyway.

* Now, launch the evaluation software application from the start menu. The software
opens and a pop up window asks to select between a ‘Standard’ mode and
‘Humidity’. Please select ‘Standard’.

*» The Found New Hardware wizard comes up again. Please select again ‘No, Not this
time’ and continue further with ‘automatic installation’.

= A message would pop up warning that the driver is not digitally signed. Please
install the driver anyway.

* Now the driver installation is complete.

» The LED on the Picoprog programmer will turn green. The software will then
initialize and ask you to connect the Evaluation board to the Picoprog programmer.

» Perform Verify Interface from the Eval.Software main window. If every is correctly
installed, the verify interface must result in an ‘Interface OK’ message. Also, under
Help 2 Programmer 2 hdIUSB 2 USBO::0Ox1894E::Ox100B::NI-VISA ought to be
seen.

» |f you want to change from the default SPI to |12C interface, please select under
Tools =2 Interface 2 I2C interface. The LED on the Picoprog programmer should
now turn red. When the LED does not glow at all, then it indicates that the

interface is faulty.
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3.2

The software comes up with a small window offering [
selections for the operating mode. In general, start
with the standard mode as it offers all options. The
humidity option simplifies and specifies the displays

for the humidity firmware. For details please see the

datasheet for the humidity evaluation kit.

The Graphical User Interface

PCap@1

acan Please select mode = @

Mode select:
| Standard | |_ Humidity |
Load Values
Pjgsets E]

Figure 3-1: Mode selection

Next, the main front panel comes up. Overall, the graphical user interface offers various

windows for on-line configuration, for parameter and calibration data setting, and of

course for the graphical and numerical display of the measurement data. The various

windows will be explained in this chapter.
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Figure 3-2: GUI Overview

3.3 Front Panel

This is the major window. On the right side, the front panel shows six general buttons:

Graph Open a window for graphic representation of measurement data

Start Start or stop a running measurement

Measurement

Write Config. Transfer once more, the present settings in the evaluation software to

the chip (in case of doubt)

Power up Reset

After Power up reset, ‘Write Config.” may be necessary.

Partial Reset

With a partial reset, the chip is re-initialized with respect to its
frontend and processor.

Verify Interface

When everything is in order, then pressing this button will confirm if an
SPI / I12C interface is present. It also indicates the release version
number of the software.

acam messelectronic gmbh - Friedrich-List-Str.4 - 76297 Stutensee - Germany - www.acam.de 3-5
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3.3.1 Measurement Page

ET acam PCa pO1

File Application Tools  Help

Grounded | Single Dg

|

Figure 3-3: Measurement page

Options on ‘Measurement’

page:

Capacitance
Measurement Scheme

Grounded | Single — Single capacitive sensor connected between a
port and ground.

Grounded | Differential- Differential capacitive sensor connected
between 2 ports with the middle tap of the sensor connected to
ground.

Floating | Single — Single capacitive sensor connected between 2
ports.

Floating | Differential — Differential capacitive sensor connected
between 2 ports with the middle tap of the sensor connected to
another 2 ports.

Please see Section 3.4 of PCapd1 data sheet for more details.
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Capacitive Reference
COo

Reference capacitance value. This setting has no effect on the chip
itself; it is purely a visual aid that helps to interpret the
measurement results better.

Span

Maximum span of the reference capacitive sensor connected. This
setting has no effect on the chip; it is only used for scaling the “Eff.
Resolution” indication.

Capacitance

These fields with an olive green background display the
measurement result at capacitive ports 3-7 provided these have
been enabled on the ‘Capacitance’ sheet.

Temperature

These fields with a pink background display the measurement result
at each temperature measurement port that has been enabled on
the “Temperature’ Sheet.

‘on’ Button : Pressing the on Button in this part of the sheet comes
up with a sub window. This helps to visually manipulate the display
of the temperature measurement result — either to display the
actual measurement value from chip or to display the temperature
directly in Celsius, Fahrenheit or Kelvin (or any other scale] by
using polynomial approximation. See section 3.2.4 for further
details.

Cmeas_dummy_en

Some differential sensors (MEMS) require mirror symmetry with
respect to the charges applied on the plates. This is ensured by
“dummy charging” and is activated by this option.

acam messelectronic gmbh - Friedrich-List-Str.4 - 76297 Stutensee - Germany - www.acam.de 3-7
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3.3.2 Capacitance Page

ET acam PCa pa1

File Application Tools Help

98088686000

Sequence Timer DSP_IND 2

Figure 3-4: Capacitance page

Options on ‘Capacitance’ page:

Cap. Port Select Select which capacitive ports have to be measured (Ports O-7), i.e.
at which ports the sensors have been connected in hardware.

Stray compensation |Internal: One additional measurement performed through only the
chip-internal stray capacitance with respect to ground.

External: One additional measurement per port pair, performed
through a parallel connection of the capacitance at the two ports
with respect to ground.

Both: Both internal and external compensation together.

None: No compensation
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Discharge Selects the value of the internal resistance through which the

Resistance discharge cycles during measurement are to be performed. This
value has to be selected in accordance with the capacitance value of
the sensor. Please see Section 3.5 of PCapd1data sheet for more
details.

Cycle Time Can be set in multiples of 20 ps that corresponds to one

Cmeas_cytime that is displayed below this box.

C_AVRG (Sample
size)

Enables averaging the measurement results over multiple
measurement cycles. Setting to 1 = No averaging, Setting to any
number N, will result in averaging over N measurement cycles for
generating one measurement result. 8192 maximum.

CMEAS_FAKE

Number of fake measurements per measurement cycle. Performing
fake measurements may help in reducing noise.

Conversion Time

Displays the entire conversion time per measurement, taking into account,
the number of ports opened and the the cycles for compensation and fake
measurements.

Cap. Trigger Select

Selects the source that triggers the start of a capacitance measurement
Single - Started by SPI Command Ox8C (Expert > Capacitance page)
Continuous — Continuous measurement, self-triggering. Recommended
when no temperature measurement is made in parallel.

Sequence timer — Depending on the setting in the ‘Sequence control’
panel. Generally recommended setting > less prone to error conditions.
Pin triggered- Triggered by external Pin, selectable from option ext.Trigger-
Pin

ext. Trigger-Pin

Used to select the pin to be used as the source of trigger for the
capacitance measurement.

NOTE: In the delivered EVA module, the pins DSP_INO and DSP_IN1 are
part of the SPl communication interface, hence only DSP_IN2 and DSP_IN3
selections are relevant.

Sequence Control :

When the timer is set to N, the capacitive measurement is triggered once
every [2A(N+1) * 20] ps

New Measurement
begins every

Displays the rate at which the capacitive measurement is triggered based
on the setting of the Sequence timer. It includes the conversion time and
the pause time before the beginning of the next cycle

Measuring rate

Displays the frequency at which capacitive measurement data (with fakes
and with averaging] is transferred from the DSP to the interface (SPI or
120).
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3.3.3 Temperature Page

[‘File Application Tools Help

Poly | internal

280us ||

CMEAS Triggered

Figure 3-5: Temperature page

Options on ‘Temperature’ page:

Temp.Sens.O (RO) To select a thermistor connected to port PTO for temperature
measurement. This could be e.g. an external PT1000.

Temp.Sens.1 (R1) To select a thermistor connected to port PT1 for temperature
measurement*

Temp.Sens.2 (R2) To select either the internal aluminum thermistor or an external

reference resistor at port PT2for temperature measurement.

Temp. Reference To select either the internal Poly or external resistor at port PT2 as
(Rref) the reference resistance to be used in temperature measurement.
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Cycle Time

Can be set to 140 ps or 280 ps. 280 ps is recommended.

T_AVRG (Sample
size)

Enables averaging the measurement results over multiple
measurement cycles. Setting to 1 - No averaging, Setting to any
number N, will result in averaging over N measurement cycles for
generating one measurement result.

TMEAS_FAKE

Number of fake measurements per temperature measurement cycle

Conversion Time

Displays the entire conversion time per measurement, taking into
account, cycles for averaging and fake measurements.

Temp. Trigger Select

Selects the source that triggers the start of a temperature
measurement
= Off / Opcode triggered: Default setting when no temperature
measurement has to be performed automatically. In this case,
a temperature measurement can still be started by SPI
Command Ox8E. The SPI Command can be sent by pressing
the button ‘Temperature Start’
= CMEAS triggered: A temperature measurement is triggered
every time when a capacitance measurement is complete.
-> Recommended setting for working with temperature
measurements.
= Timer triggered: Depending on the setting in the
‘TMEAS_TRIG_PREDIV’ counter in the Sequence Control panel.
This counter is steps up in 20 ps steps. Not recommended,
not supported by standard firmware.
= Pin triggered: Triggered by external Pin, selectable from
option ext.Trigger-Pin

ext. Trigger-Pin

Used to select the pin to be used as the source of trigger for the
temperature measurement.

NOTE: In the delivered EVA module, the pins DSP_INO and DSP_IN1
are part of the SPI communication interface, hence only DSP_IN2
and DSP_IN3 selections are relevant.

DSP_STARTONTEMP

This setting is used to start the DSP on the completion of
temperature measurement.

With the standard firmware, the DSP is started after every
capacitance measurement sequence, the temperature values are
processed at this time. If the capacitance measurement is switched
off, then setting this option will start the DSP after every
temperature measurement completion.

Temperature Start

See Temp. Trigger select - Off /Opcode triggered above

Typical configurations are:

1. No temperature measurement:

Set Temp.Trigger Select to ‘Off / Opcode triggered'.

2. Internal temperature measurement:
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Setting like in figure 3-4. Temp.Sens.2 = Alu | internal, Temp.Reference = Poly |
internal, Temp.Trigger Select to ‘'CMEAS triggered’.

3. External sensor, internal reference:

Temp.Sens.O = PTO | external, Temp.Reference = Paly | internal, Temp.Trigger

Select to ‘'CMEAS triggered’. The external sensor has to be connected at pads R1.
4. External sensor, external reference:

Temp.Sens.O = PTO | external, Temp.Reference = PT2REF | internal, Temp.Trigger
Select to ‘'CMEAS triggered’. The external sensor has to be connected at pads R1,

the external reference resistor has to be connected at pads R2.

3.3.4 Coefficients for Temperature Linearization

When you connect a temperature sensor at Port PTO
for temperature measurement, then you can set the

coefficients of the 3rd degree polynomial that is used
to linearize the temperature measurement within the

evaluation software.

When you configure the Temp.Sens.O to PTO on the
‘Temperature’ sheet, then on the ‘Measurement’
sheet, the ‘on’ button in the box with the pink
background is enabled. There are two boxes as shown
in figure 3-6, the top box is to feed coefficients for the
temperature sensor if connected at port PTO and the

bottom box is to feed coefficients for the internal

temperature sensor at port PT2, if selected.

Figure 3-6: Temperature linearization

Click on the ‘on’ button to feed in the coefficients. For e.g. when an external temperature
sensor is connected to Port PTO, then click on the off button on the top. The window

figure 3-7 pops up.
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Here you can feed in the coefficients of the 3rd degree polynomial. The coefficients

displayed by default are for a PT1000 sensor. Change them according to the sensor you
use. You can additionally also choose a filter to be applied to temperature measurement
result in software. Finally select the ‘on’ option at the top and click OK. If you do not want

the result to be linearized at all, then select the ‘off’ option.

In case you use the internal aluminum sensor for temperature measurement, then click on

the ‘on’ button in the bottom window. The window in figure 3-8 pops up.

ﬁ Temperature Calculation E Temperature Calculation

Con O Gon O

-246,94922 -257,57

238,8042 351,26

7,381117

076552057 R

Figure 3-7: Temperature linearization Figure 3-8: Temperature linearization
coefficients, e.g. PT1000 coefficients, e.g. internal aluminum sensor

The coefficients to linearize the temperature measurement when using the internal
aluminum sensor are set by default. You just have to enable it by selecting the ‘on’ option

at the top. If you do not want the result to be linearized, then select the ‘off’ option.
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3.3.5 PWM / PDM Page

I acam PCap01

File Application Tools Help

v v

do g ¢ O —

10bits » | |LFx2 v 10bits v | ILF_x2 v

Figure 3-9: PWM/PDM page

Options on '‘PWM / PDM’ Page:

Pulse Interface Select the pulse interface — Pulse Width Modulated Output (PWM) or
Enable Pulse Density Modulated (PDM) Output. Of the two, the PDM is the
recommended interface.

With PWM option, 100 kHz clock and 10-bit resolution the resulting
PWM output frequency = (100 kHz / 1024) ~ 100 Hz.

Signal source Select the measurement result which has to be given out as pulsed
output - any of the capacitance or temperature measurement
results.

Slope Used to set the slope (m) of the linearization function used to scale
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the range of the PWM / PDM output generation. See Section 4.2 in
PCapd1 data sheet for more details.

Offset Used to set the Offset (b) of the linearization function. This value
determines the range of the PWM / PDM output in the y direction.
See Section 4.2 in PCapd1 data sheet for more details.

Resolution Resolution of the output in bits. This resolution also determines the
pulsed output range.

Clock_select Selects the clock frequency to be used for the PWM/PDM
generation.
Recommended setting LF_X2 > 100 kHz

These settings refer to the use of the standard firmware. The information set is saved in

the parameter registers.
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3.3.6 GPIO Page

ﬁ acam PCap01

File Application Tools Help

’W
”i_i_i_i_

Figure 3-10 GPIO page

”o_o_o_o_
’W E

Options on ‘GPIO’ Page:

DSP_FF_IN

Pin mask for latching flip-flop activation (PGO to PG3)

DSP_STARTPIN

Not supported by standard firmware
The DSP can be started externally by a signal on a pin; these buttons
select the pin that has to be sensed for detecting the start signal.

PG_PULLUP To enable the internal pull up on the ports PGO-PG3
PG_DIR_IN To configure the ports PGO-PG3 as input (otherwise output)
PGO_X_G2 Possible only when the selected interface for communication is IIC.
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Interchange PortGO with PortG2. This is useful when the Pulsed output
is needed on Port PGO instead of PG2.

PG1_X_G3 Possible only when the selected interface for communication is IIC.
Interchange PortG1 with PortG3. This is useful when the Pulsed output
is needed on Port PG1 instead of PG3.

INT2PG2 Map the Interrupt output from chip, INTN to Port PG2.
This setting is useful for 24 pin QFN package, because the dedicated
INTN pin is absent in this version.

DSP_MOFLO Activates anti-bouncing filter in PGO and PG1 lines

3.3.7 Expert Page

Please modify the settings on the Expert page only in consultation with acam Support

team.

3.4 Front Panel Menus

3.4.1 File Menu

-~

acan gcam PCap01

m Application Tools Help
Open Conflg Strg+0O lmpi
Save Config Strg+S
OTP / SRAM E
Read Config from OTP
Close Strg+W Sp:

o

Figure 3-11: File Menu

Open Config Open configuration file *.cfg
that contains the content for
the configuration and
parameter registers.

PCap01 _Initial.cfg is the one to
start with when using the kit as
delivered.

Save Config Here you can save your own

acam messelectronic gmbh - Friedrich-List-Str.4 - 76297 Stutensee - Germany - www.acam.de 3-17



PICOCAP® PCap@1

configuration.

OTP/SRAM Opens the window to download
the firmware. See section
3.5.1.

Read Config from Reads back the configuration

OTP information in the OTP.

Close Close the evaluation software

3.4.2 Application Menu

acan gcam PCap01

File BSIETENE Tools
Me: rci

Humidity

Capacitance Measurer

Flnatinna | Sinale

Figure 3-12: Application Menu

Standard Sets the evaluation software in
the standard display mode, as
described in this datasheet.

Humidity Sets the evaluation software in
a special display mode
dedicated to our humidity
firmware. See the datasheet of
the humidity evaluation kit for
further information.
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3.4.3 Tools Menu

sesn acam PCap01

File Application mHelp

Temperature

Mmement |1 Run Measurement Strg+R

| Graph Strg+G

Chpacm"\ce ! Diagnostics Strg+D
Floating | Sing Load Settings
- l Save Settings

CMEAS_DUMN
- Read Results
Interface »

Registers
Parameter

Figure 3-13: Tools Menu

Run Start the measurement
Measurement
Graph Opens the window for graphical

display of the various
measurement results (section
3.5.2)

Diagnostics

Opens the window for numerical
display of the various
measurement results (section
3.5.3)

Load Settings

Load the settings file *.set that
contains the display information
(labels, number of fractional digits
e.t.c.)

Save Settings

Saves the current display
settings.

Read Results

Single read of the result registers

Interface Select between SPI and 12C
interface

Register Opens the Register window
(section 3.5.4)

Parameter Opens the Parameter/Calibration

=100=1n

mess-electronic
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window (section 3.5.5)

3.4.4 Help Menu

File Application Tools [

: Help Contents F1
B pogomme |

About

Floating | Single

Figure 3-14: Help Menu

Help Contents Opens the help window

Programmer Opens the window with
information about the NI VISA
interface and the possibility for
interface tests

About Version
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3.5 Special Windows

3.5.1 OTP/SRAM Communication Window

In the ‘File’ Menu you can select 'OTP/SRAM’ and the following window pops up:

Figure 3-15: OTP/SRAM Communication

Open File Select and open a firmware file (.hex]). The content is shown in the
‘Write Data’ window.

Read SRAM Pressing this button, the content of the SRAM is read and shown in
the ‘Read Data’ window. In ‘Address’ and ‘Length’ you can specify how
many bytes you want read, starting at which address.

Write SRAM Writes the firmware into the chips SRAM. The status of the write
process is indicated by the green bar. The successful end is indicated
by a pop-up window. For verification we recommend to read back the
SRAM afterwards and compare it with the source.
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Read OTP Pressing this button the content of the OTP is read and shown in the
‘Read Data’ window. In ‘Address’ and ‘Length’ you can specify how
many bytes you want read, starting at which address.

Write OTP Whrites the firmware into the chips OTP.

Attention: This option should be used only if you really want to test the
OTP functionality.

The status of the write process is indicated by the green bar. The
successful end is indicated by a pop-up window. For verification we
recommend to read back the OTP afterwards and compare it with the
source.

oTP

Write Config to

Whrites to current content of the configuration registers into the
reserved OTP space.

Firmware Version

In the firmware, a specific address is reserved to save 3 byte
information about the application and the version of the software. The
coding is specified in the pcapO1a.h library (see assembler)

3.5.2 Diagnostics Window

acan Djagnostics o | @ ‘-23_
Name Results Shift Factor | Offset Span Final Result | Mean %2? Std Dev SNR [bit]
coLs [<47.0> 022202 Jufs 0 [1 0 1 139986k 139,993k 7,547 -2,916
C1/C0 <47.0> 207AD5 U :{ 2101 0 1 1,015 1,015 72,163u 13,758
C2/C0 <23..0> 000000 iﬁ -21 47p 0 10p 0 0 0 Inf
C3/C0 <23..0> 000000 ij -21 47p 0 10p 0 0 0 Inf
C4/C0 <23.0> 000000 U] a -21 | 47p 0 10p 0 0 0 Inf
C5/C0 <23..0> 000000 i:ﬁ -21  47p 0 10p 0 0 0 Inf
C6/C0 <23..0> 000000 _u_: -21 | 47p 0 10p 0 0 0 Inf
C7/C0 <23..0> 000000 ij -21  47p 0 10p 0 0 0 Inf
FR8 <23..0> 000008 _u_:ii 0 |1 0 1 8 8 0 Inf
FR9 <23..0> 000008 i:j 0 1 0 1 8 8 0 Inf
Temp0 | <23.0> 000000 | U] Temperature Polynom on -- T0 / °C -246,949 -246,949 0 Inf
Temp2 | <23.0> 1A5407 | u| Temperature Polynom on -- T2/ °C | 31,432 31,415 20,313m 12,528

Figure 3-16: Diagnostics Window

The ‘Diagnostics’ window is used for real-time numerical display of the measurement

results. In principal it shows the content of the read registers. The content itself depends

on the firmware. Figure 3-16 shows the content as it is given with the standard firmware.

The first eight rows show the capacitance ratios, the last two rows show the temperature

result (resistance ratio or linearized temperature).

The ‘Diagnostics’ window has 12 columns of information, defining labels, data format,

resolution specification (white background) and results (grey background). The information

in the white fields increase convenience of reading and is stored in the setting files (*.set).
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All number may get a character to indicate the well known prefixes for denoting the factor

[N

in thousands (‘p’,'f’,'a’,’k’... ).

Name Label for the register content, depends on the firmware.

Results Raw hex data display of the result register content. The column before
shows the width. The button column after shows whether the result is
signed or unsigned.

Shift This column shows the size of the fractional part of the fixed point number
and the necessary shift. Depends on the fimware.

Factor The factor is a scaling factor that allows to scale the result according to the
reference capacitor. Factor = ‘1’ gives back the initial capacitance ratio in
column ‘Final result’ (see figure 3-16). ‘47p’ scales the result to a 47 pF
reference capacitor as it is assembled default on the evaluation board (see
figure 3-17).

Offset Offset to be added or subtracted in the evaluation software.

Span Number that defines the maximum span of the sensor. Is relevant only for

the calculation of the resultion in column SNR[bit].

Example figure 3-16b: The sensor has a base capacitance of 47 pF and
varies by

10 pF. The 10 pF span are resolved with 11.4 bit.

Final Result

Display of the final result, scaled by ‘Factor’ and the ‘Offset’ added.

Mean Display of the mean value. The sample size can be selected.
Std.Dev Standard deviation of the ‘Final Result’.
SNR Signal-to-Noise ratio in bit, calculated as ‘Span’/ ‘Std.Dev.’

acan Diagnostics (o = 7827
Name Results Shift| Factor | Offset Span Final Result | Mean ?1.3‘— Std Dev SNR [bit]
COLSB | <47.0> 0222C4 EE‘ 0 1 0 1 139,972k 139,964k 8,879 -3.15
C1/C0 <47.0> 207A9C U :{ -21 | 47p -700f 10p 47,003p 47,004p 3,601f 11,439
C2/C0 <23..0> 000000 i: -21 | 47p .-0 10p 0 0 0 Inf
C3/C0 <23..0> 000000 ij -21 | 47p 0 10p 0 0 0 Inf
C4/C0 <23.0> 000000 u 341 -21 | 47p 0 10p 0 0 0 Inf
C5/C0 <23..0> 000000 Lj -21 | 47p 0 10p 0 0 0 Inf
C6/C0 <23..0> 000000 U :1 -21 | 47p 0 10p 0 0 0 Inf
C7/C0 <23..0> 000000 | u ;4 -21 | 47p 0 10p 0 0 0 Inf
FR8 <23.0> 000008 _9_3% 0 1 0 1 8 8 0 Inf
FRS <23..0> 000008 _u_j 0 1 0 1 8 8 0 Inf
Temp0 | <23.0> 000000 U] Temperature Polynom on -- T0 / °C -246,949 -246,949 0 Inf
Temp2 | <23.0> 1AS9E8 | u| Temperature Polynom on -- T2/ °C | 31,684 31,693 14,762m 12,989

Figure 3-16b: Diagnostics Window
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3.5.3 Graph Window
acan Graph
35,1452~
351~ aco e
35,05- o [l
35- aro Il
34,95- @y |
349- csico [
34,85- /0 [l
34,8- aco Il
g 3475~ e
£ ;7- o
£ ues- Tempo [
34.6- Temp2 [
34,55~ ¥ /div|50m
34,5-
34.4- :
34,35-
343+
34,2555-] - N - - - - - —
44322 44400 44500 44600 44700 44800 44900 45000 45122
aniples
Data Reduction '.;);_1_ | Save Data to Filel | Diagnostics ‘ feom bk ‘Cullea'r ;( ljn CIQ,,

Figure 3-17: Graph Window

The data to be displayed are selected in the field at the bottom right. The labels in the
buttons are the same as in the diagnostics window. To display data press the
corresponding button so that it gets green. Below the graph are various options to zoom

in/out, center or scale in other ways.

The data displayed can be stored into a text file. For long-term investigations it is possible
to reduce the data displayed and stored. The field ‘Data Reduction’ allows to define the

level of data reduction.

3.5.4 Registers Window

These windows display the configuration data in hexadecimal format as they are currently
used. Also the result registers’ content is shown in hexadecimal format, but updated only

when the button is pressed. Finally, the various status bits are shown.
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Figure 3-18: Write and Read Registers

3.5.5 Parameter Window

This window shows the content of the parameter registers and, if supported, the
calibration data. The content strongly depends on the firmware. The standard firmware

does not use calibration data but e.g. the humidity firmware and pressure firmware do.

The parameter registers are used to scale the pulse output interfaces and to tell the

firmware whether differential sensors are used.
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PARAMO
PARAML

pulse_sele

pulsel_slo
pulse0_off
pulsel_slo
pulsel _off
differentia) 55

Gain_Corr[ 476,837n |21

Figure 3-19: Parameter Window

Calibl
Calib2 | -63,219k
Calib3 | 391257M
Calibd | 3,86983M
Calib5 | 1,60541M
Calibs | -1
Calib7 | 809,715k
Calib8 | -2,67351N
Calib9 | 2,79085M
Calibl0 | -914,256k
Calibll | 2,936k
Calibl2 | 2,22298M
Calibl3 | -531,838k
Calibld | -790
Calibls | 1,637k
Calibls | 512
Calibl7 | 2,619k
Calibls |1
Calibl9 | 21,76k
Calib20 | -163841k
Calib2l | 3,95264M
Calib22 | -1,969k

FFFFFF
FF090D
3BB378
3B0C87
187F25
FFFFFF
C5AF3
D73497
2A95C6
F20CBO
B78
21EB85

FDTFFF
3C4FFF
FFF84F

0000 000000000000 o000 o0 oo

Figure 3-20: Calibration Window
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3.6 First Measurement: Step-by-Step

Step 1: The first to do after starting the evaluation software is to download a firmware
into the PCap™d1. In the initial phase start with our standard firmware that calculates the
capacitance ratios and resistance ratios. It automatically recognizes the operation mode
and takes care of the set number of capacitors and the kind of connection. But it does no

further processing.

Open the ‘File’ menu and select OTP/SRAM. The following ‘OTP/SRAM communications
window’ opens. If you press ‘Open File’ initially the content in the ‘data’-folder of the
PCap@d1 program folder is opened. There you find the firmware PCap0O1_standard.hex.

Select this one.

Suchenin: || data

o~

= } Name i Anderungsdatum
7| PCap01_humidity.hex 15.09.2011 09:44
Zuletat besucht | 3] pcap01._standard.hex 31.08.2011 1436
! @ uni_prg_v064.hex 30.03.201113:13
Desktop
Bibliotheken

Figure 3-21 File menu

Press ‘Write SRAM’ and wait till the green bar indicates that the write process is finished.

For verification press ‘Read SRAM’ to check if the content is correctly written into the
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SRAM. In the ‘Read Data’ you should see the same content as in the first 128 byte of
‘Write Data’.

Step 2: The next step you need to load a configuration file. This file contains the
configuration registers content and the parameter registers content. Select in the ‘File’
menu item ‘Open Config’ and select the file PCap01 _initial.cfg. This configuration fits to the

evaluation board in its initial assembly with floating 47pF capacitors.

File Application Tools Help

Suchenin: || data vy O3 @

{ Name ’ Anderungsdatum
7] PCap01_020101.cfg 280720111609  CFG-Date
| Zuletztbesucht |5 pcang) HighRes.cfg 06.09.201116:58  CFG-Date
7| PCap01_humidity.cfg 111020101343  CFG-Date
| 7] PCap01_Initial.cfg 07.09.2011 08:15 CFG-Date

Figure 3-22: Load Configuration Data

Step 3: Finally, load the standard settings file to have a reasonable display in the

Diagnostis window and Graph window.

File Application Tools Help

Suchenin: |, data v @ &% =@

(3 Name = Anderungsdatum  Typ
: | PCap01_humidity.set 230220110945  SET-Datei

| Zuletztbesucht |77 pcap01 standard.set 07.09.201108:16  SET-Datei

Figure 3-23: Load Settings Data

Step 4: Open the Diagnostics window and Graph window and press ‘Start Measurement'.
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q Assembler
Features
Platform: \Windows 2000, XP, Vista (32-Bit), Windows-7 (32 and 64)

Type of Assembler:

Single Path Assembler

Source-File: * .asm, according to the PCapd1 assembler syntax
Target-File: Output. hex, downloadable Hex-File
Instruction: <command> [ <parameter1>, <parameter2>]

For example:

nop or adda, b or |jCarC case’
Comment(s): Single line comment:

Multi line comment: <COMMENT> <ENDCOMMENT>
Includes: <command> [ <parameter1>, <parameter2>]

For example:

nop or adda, b or |CarC casel
Constants: Constants can be defined with:

CONST myConst8 15
The constants have to be declared before they are used for the first
time.

Number formatting:

Numbers can be written in decimal or hexadecimal notation
e.g.: load a, 16355 or load a, Ox3FE3

Jump labels:

To jump within the code, you can use jump labels together with the
various conditional jump op-codes like jed p1, JEQ p1 etc.

E.g.: jCarC label1

label1: move a, b

Addressing:

Addressing is automatically done by the assembler. Please note that
the maximum user program size is 4kB (including all header files,
library files and calibration banks]).

Subroutines:

Subroutines can be executed with the special opcode ,jsb‘’ and ,jrt'.

4.1

Installing the Assembler

Insert the CD-ROM. Run Software\PCapO1_Assembler 2.0.3\setup.exe to install the

program. Restart the computer if required. After the installation you will find in the START

menu an item ,PCapd1 Assembler®. Run this to start the assembler program.

4-2
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4.2 Running the Assembler

In the START menu there is an item ,PCapd1 Assembler”. Run this to start the assembler

program.

4.2.1 Assembler Online Help

The following sections give just a short description of the assembler program. For a
detailed description of the assembler software please use the online help of the program.

The online help can be opened from the Menu or by pressing the F1 button.

The following help window opens up:

E? acam PCap01 Assembler Help

28 B
Ausblenden Crucken Cptionen
[£] Introduction

e PCAP Assembler Help .

+ @ fesembler mess-electronic
License Agreement
[E] About PCAP Assembler Softwars
This help file is shipped as part of the PCAP Assembler Software which is provided by acam
messelectronic gmbh, Germany. The help file provides information about the software environment, the
assembler syntax and the usage of the tool. The help file contains several sections:

Mew with PCAP See what changes with PCAP Assembler Software.

User Interface  Contains information about the Graphical User Interface (GUI), e.g. the several available
tabs, the toolbar and the menu.

Assembler Detailed usage description of the assembler syntax and how to program your
application.

Furthermore you can find license information and general information about the software and acam here.

© 2006-2010 acam messelectronic gmbh, Germany. All rights reserved

Figure 4-1: Integrated online help of PCap01 Assembler
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4.2.2 Assembler Page

I acam PCap01 Assembler - c:\Programme\acam-messelectronic\PCap0 1\Assembler\examples\pressure sensor\PCap01_pressure.prj

Flle Edit View Assembler Tools Help
[EsE e DOZo e|b|xQldak

B PCap01_pressure asm chc inv.h I median h | rdch | signed24_to_signed48h I standard.h I pcapliah I
= RES4: Capacitance measurement ratio with 22 fd v
E, RESS: a2 : Coefficient in polynomial for Llinearization of pﬁeslsure
= RES6: al : Coefficient in polynomial for Linearization of pressure
I | RES7: a8 : Coefficient in polynomial for Linearization of pressure
£ RESS: -
E RESS: -
a RES1@: -

RES11: t_ref / t_meas value from Capacitance ratio measurement

NOTE : Those Lines of the firmware that have to be adapted to the sensor are marked with
" --» Adapt from Excel sheet " in the following source code.
Authar: OH, VK - acam messelectronic gmbh (c) 2818

FfirstSignedCalValus @

; mm—-—------ signed Calibration Values Registers ( must be placed at ascending Ram-Addresses!)
tho e coefficient Temperature Polynom

)
thl 1 ; coefficient Temperature Polynom
th2 2 ; coefficient Temperature Polynom
th3 3 ; coefficient Temperature Polynom
@ CONST pc32 4 ; coefficient Pressure Polynom A2 v
c:\Programme'acam-messelectronic'.PCapl1'Assemblerexamples*pressure sensorPCapl1_pressure asm _ .

WARNING: configuration for program memory model not found. assuming single mode _‘I
INFO: Program Size: 2450 Byte

INFO: c:“Programme“acam—messelectronicPCapll-Assemblersexamples pressure sensor~PCapll_pressure.asm: Processing was
=successful

Figure 4-2: Assembler source code window

The ‘Assembler’ tab is the main window to open all the source code and include files. It consists of
a status message window at the bottom and buttons to operate the assembler. By clicking the
green link labeled ,Opcode-Help (F2)° an integrated online help pops up which provides detailed

information about the available op codes.

The controls in detail:

Source code window: This window is used as the source code and include files editor for the
assembler listings (*.asm & *.h files). This is a pure editor window;
any number of tabs can be opened in this window. This page allows the
user to display and edit any file. The files can be manually opened,
saved and closed. The location of the file displayed in the window
currently is displayed next to the ‘Compile’ button.

Additional features are line numbering, syntax highlighting and
integrated comment handling. Standard editor tasks like cut, copy &
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paste or find & replace, etc. can be performed. You can modify the
settings for the editor via the tool settings dialog. To know more about
‘Include’ files and how to use them, see section 4.2.2.1 below.

Assembler button:

The assembler button to compile the source code along with the
respective header files is: Compile.

On pressing the Compile button the source file is compiled to a
downloadable hex code. If the compilation was successful a message is
displayed accordingly. If the compiling fails, an error message occurs.
If more than one source files are currently open, then the *.asm that
will be compiled on pressing the Compile Button, has the filename in
bold letters on the tab. It is the first opened .asm file in the window
that is always compiled.

Save Project button:

When a source code (*.asm] file and all the respective include (*.h)
files are open in the Assembler tab, then all the files can be combined
and saved in a project file (*.prj), by pressing the Save Project button.
The .prj file always takes the name of the *.asm file.

For e.g. A source code file sample.asm uses ‘include’ files include1.h
and include2.h. Then the corresponding prj file would be saved by the
name sample.prj. Once saved, the project file can be opened from the
menu File > Open project - *.prj file. This automatically closes all
currently open files and opens all the files (*.asm and *.h) belonging to
the project in one go. The *.prj file can also be opened and edited in
this Window.

Note1: The .asm and .h files can be in different folders or locations.
The *.prj file stores the location of the file while saving the project.

Note2: When the PCapd1 Assembler software is closed, a .prj project
file is automatically generated with all the files that are currently open
in the window. The name of this project file will be that of the open
source code file with a .prj extension. This .prj file will be used to open
all these files again when the PCapd1 Assembler software is started
again.

Open Project button:

An already saved project (with a *.prj file), can be opened using this
button

Status message window:

In this window there are the output messages of the assembler
displayed. In case the assembly process was successful, a
corresponding message appears with the path of the file that was
compiled. If an error occurs while assembling, an error message
appears together with the line number and the file name in which the
error occurred. An error in any of the source code (*.asm] file or
“include” (*.h) files is identified and intimated with the path of the file.

Opcode-Help:

Between the source code window and the status message window

acam messelectronic gmbh - Friedrich-List-Str.4 - 76297 Stutensee - Germany - www.acam.de 4-5




PICOCAP® PCap@1

there can be found a green link labeled ,0Op code-Help (F2)'. By clicking
this link another window pops up. The window contains the op code
online help. Every supported op code is explained there in detail. The
additional windows are based on the integrated Microsoft Windows ®
Help system and can be operated separately. (Windows is a trademark
of Microsoft Corporation)

Running the assembler in order to compile your source file is the first step when using the
PCap@d1 Assembler Software.

An integrated ‘examples’ folder provides some readymade firmware code for downloading into the
PCap@d1 chip. The standard firmware (.asm and .hex) is present in the ‘standard’ folder under

‘examples’.

The user can also add his own examples to the ‘Examples’ folder with the respective prj file. The
prj file can be written manually (See format of existing prj files in the Examples folder) or can be
allowed to be generated by the assembler with the Save Project button. The Search-Examples
dialog box can be accessed via the Help menu or by pressing F4 or by clicking on the ‘Bulb’ icon
on the top. Only *.prj project files can be opened via the Search Examples option. To open

individual files, use the File - Open option.

4.2.2.1 ‘Include’ files

The basic idea of supporting ‘include’ files is to provide more modularity and flexibility
within your code. That means, instead of packing all needed source code to a single
assembler listing (*.asm files) you can roll out some pieces of code to the include files
(also called header files with extension *.h). The advantage of this method is, that the
readability of your code will be improved and that once written parts of code can be reused

(e.g. configuration information).

To include parts of code by using a include file there are two steps needed.

Step 1: Create an include file (e.g. config.h).

Step 2: Declare the inclusion in your assembler listing as follows: #include ,config.h”

Include files that are in the same folder as the source file (*.asm) can be included with
#include “filename.h”. Include files that are in a path one level higher than the source file
can be included with “../filename.h”. If there is a set of common include files, they can be

segregated in a folder called Lib in PCap0O1 \Assembler\lib. The ‘include’ files in the lib

4-6 acam messelectronic gmbh - Friedrich-List-Str.4 - 76297 Stutensee - Germany - www.acam.de



|
Pcap@1 mess-electronic

folder can be included in the program by using #include <filename.h>. They are

automatically included from the lib folder.

On installing the assembler software, the PCap01 \Assembler\lib is pre-installed. It
contains all the library and header files that are used in the examples. You can add your

library or header files to this folder.

The alternative method of using a single assembler files without using ‘include’ files at all is

also supported.

4.2.3 Download Page

The ‘Download’ tab displays the compiled hex code that can be downloaded into the
PCapd1 chip. The hex-file is displayed in rows with 16 bytes per row. The location of the
displayed hex file is shown at the top of the window. Now this hex file can be written into

the OTP or the SRAM of the PCapd1 chip for e.g. using the Front panel software.

IT acam PCap(1 Assembler - c:\Programme\acam-messelectronic\PCap(01\Assembler\examples\pressure sensor\PCap01_pressure.prj

File Edit Wiew Assembler Tools Help
Df_'_»‘(_%'_)‘@m DG|E§@| ) @ %|\}|-|ﬂ‘g

Hex-File c\Progr '\ lectronic\PCap01\A blern les\pressure sensor\PCap01_pressure_hex

00 00 70 BE 01 20 A2 66 67 76 77 66 42 5C 48 43
58 ED 44 84 03 27 37 20 %4 Al 01 20 2F A0 01 20
2F A3 01 20 2F A4 01 20 2F A4 01 20 2F A5 D7 00
26 6D D4 43 44 D5 43 F7 44 20 45 20 5F 78 68 01
00 00 00 20 07 D5 41 JF F6 43 A% 03 6F F6 58 58
5D BF 02 42 5D 5D 42 A8 03 60 5C A9 00 70 02 7A
c0 CcD CcO D5 FF 43 EC 44 F4 41 2B 16 EA 45 F5 41
2B 16 ES 45 1D 41 43 58 EA 29 2D E9 50 46 EB 44
A% 02 EB 5% 43 CA FE 41 5C A8 03 D3 5A EB 45 EB
41 F2 45 02 D3 43 D2 59 AR 06 75 65 7A DA 43 D2
44 02 7E 7A DA 43 D2 44 6A C0O FE 43 D3 44 EF 45
BB 22 10 D8 FE 41 5D C0 FE 43 5D AB 13 47 AB 12
47 AB 11 47 AB 10 47 AB OF 47 AB 0E 47 AB 0D 20
DF 22 17 22 Al 23 2B 23 BS 24 3F 24 C9% 25 53 25
DD D7 FE 43 CF FE 41 D% 45 CcO CcO CO CcO FF 41 ED
45 1F 41 2B 16 1F 45 D3 41 ED 53 D9 41 47 45 AR
EF 20 30 FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF 00
FF FF FF FF FF 43 02 D0 c0 c0 Cc0 FF 43 Dl 44 FF
FE FO CO FF 43 C0O 44 c0 c0 c0 c0O FF 43 cl 44 c0

A0 AN SN BT AT AT AA e e o0 on Bw AT 3 AA T

B

whload  Assemblar
¥

| Do

Figure 4-3: Hex-file display
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2.4 Assembler Settings

PCap@1

Different settings for the assembler and the editor can be done by selecting the item

“Settings” in the “Tools” menu. A screen appears that shows the following sheets:

Settings

Ervironment I Editor I

Window settings
W Alow Window Maxdmization

¥ Show hints
W Show tooltips

Lanouages:
W Automatic codepage detection at startup

" Restore default settings

Cancel
[ Clear ALL settings frequires application restart)

Figure 4-4: Environment settings

| Settings

Environment = Editor I

Editor settings:
[V Show line numbenna:

[V Line numbering in gray
V' Apply syntax highlighting

[~ Enable Muttibyte Support

s :
[~ Restore default settings Aoply Cancel

[ Clear ALL settings {requires application restart)

Figure 4-5: Editor settings

4-8
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5 Miscellaneous

5.1 Literature Guide

Data Sheets

Title Document-No Date
PCapd1Ax-0301 DB_PCap01Ax_0301_en.p | May 2011
Single-chip Solution for Capacitance df

Measurement with Standard Firmware
version 3.0

PCapd1AK-0101 DB_PCap01AK- February 2011
Single-chip Solution for Humidity 0101 _en.pdf
Measurement

PCapd1-DSP Description of the digital signal | DB_PCap01_DSP_e.pdf Aug 2011
processor

White Papers

Title Document-No Date
Linearization of Pressure Sensors | WPOOS5_e.pdf Sep 2011
with PCap@d1

Application Notes

Title Document-No Date

Cable compensation ANO26 V1.0 In preparation

All available documents can be downloaded from the acam website at:

http://www.acam.de/download-center/picocap

5.2 Document History
26.02.2013 Correction in section 2.2, C1 = 33 nF COG, Version 0.3
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Appendix

Schematics

6.1
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Figure 6-1: Motherboard schematics
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Figure 6-2: PCa01 AD module schematics
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Figure B6-3: PCa01 AD module layout
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